
 

 

 
 

Symprex Folder Permissions Manager 
 
 

User’s Guide 
 
 
 

© Symprex Ltd. All Rights Reserved. 
 

Version 4.5. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Symprex 
 
Symprex Ltd., 
London, England. 
 
Web: http://www.symprex.com 
 
General: info@symprex.com 
Sales: sales@symprex.com 
Support: support@symprex.com 

http://www.symprex.com/�
mailto:info@symprex.com�
mailto:sales@symprex.com�
mailto:support@symprex.com�


Table of Contents 

  Symprex Folder Permissions Manager User’s Guide  │  2 

TABLE OF CONTENTS 
1 Introduction ...................................................................................................... 3 

1.1 System Requirements ............................................................................... 3 
1.2 Permissions Requirements ....................................................................... 3 

2 Tutorial ............................................................................................................ 4 
2.1 Getting Started .......................................................................................... 4 
2.2 The Main Application Window ................................................................... 4 
2.3 Menus ....................................................................................................... 5 

2.3.1 File Menu ........................................................................................... 5 
2.3.2 Tools Menu ........................................................................................ 5 
2.3.3 Templates Menu................................................................................. 5 
2.3.4 Help Menu .......................................................................................... 6 
2.3.5 Context-Sensitive Menu ..................................................................... 6 

2.4 Options ..................................................................................................... 6 
2.5 Apply Permissions to Group ..................................................................... 7 
2.6 Report ....................................................................................................... 9 

3 Templates ...................................................................................................... 10 
3.1 The Templates Manager ......................................................................... 10 
3.2 The Template Wizard.............................................................................. 10 

3.2.1 Welcome .......................................................................................... 11 
3.2.2 Step One – Name and Type of Template ......................................... 11 
3.2.3 Step Two – Modified Objects ........................................................... 12 
3.2.4 Step Three – Configure Folders and Permissions ............................ 12 
3.2.5 Ready to Create/Update Template ................................................... 13 
3.2.6 Finished! ........................................................................................... 13 

3.3 Applying a Template ............................................................................... 13 
4 Miscellaneous Issues .................................................................................... 16 

4.1 Public Folders and the Owner User ........................................................ 16 
4.2 Setting Folder Permissions ..................................................................... 16 

4.2.1 Name/Role ....................................................................................... 16 
4.2.2 Permissions ...................................................................................... 16 
4.2.3 Roles ................................................................................................ 16 
4.2.4 Read Permissions ............................................................................ 17 
4.2.5 Write Permissions ............................................................................ 17 
4.2.6 Delete Items ..................................................................................... 18 
4.2.7 Other Permissions ............................................................................ 18 

5 Required Account Permissions ..................................................................... 19 
5.1 Exchange 2000/2003 Account Permissions ............................................ 19 
5.2 Exchange 2007/2010 Account Permissions ............................................ 19 

6 Contacting Symprex ...................................................................................... 21 
6.1 Visit Our Web Site .................................................................................. 21 
6.2 Contact Us by Email ............................................................................... 21 
6.3 Contact Your Local Reseller ................................................................... 21 
 



Introduction 

  Symprex Folder Permissions Manager User’s Guide  │  3 

1 INTRODUCTION 
Symprex Folder Permissions Manager is a powerful application that allows you 
to view and change permissions on folders within individual mailboxes, groups 
and address lists. Common sets of permissions can be stored within templates 
and applied as desired to make repetitive tasks much simpler. Permissions can 
be applied to a folder and its sub folders, or to any set of folders on the server, 
and specified permissions can be appended, replaced, removed or updated. 
 
Symprex Folder Permissions Manager is also the perfect tool for maintaining 
and enforcing permissions on mailboxes and folders according to a defined 
policy. For example, it is easy to ensure that all receptionists have Reviewer 
permissions on all Calendar folders, or that all users have Author permissions 
on all Contact folders. 

1.1 System Requirements 

Symprex Folder Permissions Manager requires: 
 

• When installing on workstation:

• 

 
Microsoft Windows 2000, XP, Vista or 7 
Microsoft Outlook 2000, 2002, 2003, 2007 or 2010 
When installing on server:

• 10 MB free hard-disk space 

 
Microsoft Windows Server 2000, 2003 or 2008 
Microsoft Exchange Server 2000, 2003, 2007 or 2010 

• 800 x 600 or higher screen resolution 
• Supports use via terminal services on the above listed server platforms 

 
Symprex Folder Permissions Manager can access mailbox and public folders 
on any Exchange 2000, 2003, 2007 and 2010 server. 

1.2 Permissions Requirements 

Symprex Folder Permissions Manager requires you to be logged on to Windows 
with a domain account that must have certain permissions in the domain and on 
your Exchange server (see §5). 
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2 TUTORIAL 

2.1 Getting Started 

Symprex Folder Permissions Manager is started by clicking its icon in the 
program group. If the application is running in evaluation mode, a window will 
be displayed advising you of the number days remaining in the evaluation 
period. If you have purchased a license, you can enter it by clicking the Enter 
Registration… button. 
 
After the splash screen has been displayed, you may be required to select the 
profile of the Exchange user you wish to connect as. Once successfully logged 
on, the main application window will be opened. 
 
Symprex Folder Permissions Manager requires you to be logged on to Windows 
with a domain account that must have certain permissions in the domain and on 
your Exchange server (see §5). 

2.2 The Main Application Window 

The main application window is split in to two parts. 
 

 
 
The left-hand side of the window displays a tree of your Exchange system, 
including all address lists, distribution lists, mailboxes and folders for each 
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mailbox, and the Public Folders. Expanding the nodes (either by double-clicking 
the node itself or clicking the “+” box to the left of the node) will reveal the 
contents of that node. 
 
Note By default, the application shows all folders within each mailbox. This can 
be modified by the “Only Show Default Folders” option; see §2.4. 
 
The right-hand side of the window displays the permissions for the currently 
selected folder from the Exchange system tree (when a non-folder node is 
selected, the controls will be disabled). 
 
The main list shows the users who have permissions on the selected folder. 
The list may be changed by using the Add and Remove buttons, or you may 
view the properties of an existing user in the list by clicking the Properties 
button. Below the list, the permissions that the selected user has are displayed. 
To change the permissions, either select the pre-defined role from the drop-
down list or set custom properties using the appropriate check boxes. 
 
Check When applying permissions also apply to sub-folders to apply the 
permissions to the currently selected folder and its sub-folders. 
 
Once you are happy with the changes made, click the Apply Permissions to 
Folder button. Alternatively, to restore the original permissions as currently set, 
click the Refresh Folder Permissions button. 
 
Note For a full description of how permissions can be set, see §4.2. 

2.3 Menus 

2.3.1 File Menu 

The File menu contains the following items: 
 

• Options – displays the Options dialog (see §2.4). 
• Exit – closes the application. 

2.3.2 Tools Menu 

The Tools menu contains the following items: 
 

• Apply Permissions to Group – displays the dialog to set the permissions 
of a group of folders (see §2.5). 

• Generate Report – generates a report of the permissions for the selected 
group (see §2.6). 

2.3.3 Templates Menu 

The Templates menu contains the following items: 
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• Manage Templates – displays the Templates Manager window (see 

§3.1). 
• Apply Template – when an item from the Exchange system tree that can 

have a template applied is selected, this menu item displays the 
Template Manager window is Apply mode (see §3.3). 

2.3.4 Help Menu 

The Help menu contains the following items: 
 

• Contents – displays the help system for the application. 
• Symprex Web Site – opens your default Internet browser at the Symprex 

Web Site homepage. 
• Symprex Support Page – opens your default Internet browser at the 

Symprex support web page. 
• About – displays the About box for the application. 

2.3.5 Context-Sensitive Menu 

The context-sensitive menu is displayed when an item in the explorer is right-
clicked. The menu contains the following items: 
 

• Apply Permissions to Group… – displays the dialog to set the 
permissions of a group of folders (see §2.5). 

• Apply Template… - displays the dialog to apply a template (see §3.3). 
• Manage Templates… - displays the dialog to manage templates (see 

§3.1). 
• Refresh… - refreshes the selected item. 
• Generate Report… – displays the report dialog (see §2.6). 

2.4 Options 

The Options dialog is opened by selecting the File > Options… menu item. The 
following options are available: 
 

• Only Show Default Folders – forces the explorer to only show the default 
Exchange folders within each mailbox. This can be faster than retrieving 
all of the folders within a mailbox. 

• Confirm applying new permissions – makes the application prompt for 
confirmation when new permissions are being applied. 

• Give restored user default rights (Outlook behaviour) – in Microsoft 
Outlook, if a user is removed and then re-added to the list of 
permissions, they are always assigned the default rights. This can be 
annoying if the user had other rights when they were deleted. By de-
selecting this option, the application will restore the original rights for the 



Tutorial 

  Symprex Folder Permissions Manager User’s Guide  │  7 

user if they are removed and re-added, but only whilst the changes have 
not been applied. 

• Disable Splash Screen (Registered Version only) – prevents the splash 
screen from being displayed when the application is started. This setting 
only has effect in the registered version of the application. 

• Use Current Profile – when checked, the application will log on your 
Exchange Server using the current mail profile if such a profile is 
currently logged on (for example, if you are using Microsoft Outlook). If a 
profile is not available or this option is not checked, the “Choose Profile” 
dialog is displayed when the application starts. 

2.5 Apply Permissions to Group 

This dialog allows permissions to be set to a group of folders without the 
requirement to create a template. To open the dialog, select the appropriate 
group and either select the Tools > Apply Permissions to Group… menu item 
or right-click the item and select Apply Permissions to Group. 
 

 
 
The top of the dialog displays the group that will be modified. Select how the 
permissions will be applied from the options at the top of the dialog (see below 
for more information on these options). Then select the folders that will be 
modified from the list of the left of the dialog, and which permissions will be set 
on the right of the dialog. 
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You can choose how permissions will be applied from one of the following 
options: 
 

• Append Mode – only new permissions are added; any existing 
permissions on the folders will remain in place and will not be overwritten 
by the permissions defined in the template. 

• Overwrite mode – all existing permissions (except those of the Default 
and Anonymous users) are removed and overwritten by the permissions 
defined in the template. 

• Overwrite, No Delete mode – all existing permissions are overwritten but 
those not specified in the template will not be removed. 

• Remove – all permissions specified in the list will be removed but other 
existing permissions will not be altered. 

• Update – all permissions defined in the list will be updated but any that 
do not exist will not be created. 

 
Note The permissions for the Default and Anonymous users can be updated 
but if they do exist within the permissions for a folder, they will not be created. 
 
Note For a full description of how permissions can be set, see §4.2. 
 
The three check-boxes at the bottom of the window control are context-sensitive 
to the type of object selected in the explorer. They will be available as follows: 
 
When a Single Mailbox is Selected 
 

• “Preview Modified Mailboxes” is disabled. 
• “Apply to Sub-Folders”; when checked, any user-created folders within 

the selected top-level folders will be modified. 
 
When a Mailbox Group is Selected 
 
NB. A “Mailbox Group” is a generic term for Distribution and Address Lists 
 

• “Preview Modified Mailboxes”; when checked, will cause a list of the 
mailboxes that will be affected by the changes to be previewed in a 
separate window. 

• “Apply to Sub-Groups”; when checked, all child mailbox groups within the 
selected group will be modified. 

• “Apply to Sub-Folders”; when checked, any user-created folders within 
the selected top-level folders will be modified. 

 
When a Public Folder is Selected 
 

• “Preview Modified Folders”; when checked, will cause a list of the folders 
that will be affected by the changes to be previewed in a separate 
window. 
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•  “Apply to Sub-Folders”; when checked, any sub-folders within the 
selected Public Folder will be modified. 

 
To apply the permissions to the objects within the selected group, click the 
Apply Permissions button. To close the dialog without applying any changes, 
click the Cancel button. 

2.6 Report 

The Report dialog is used to generate a file containing the permissions set on 
the objects within the selected group of the explorer. To open the dialog, select 
the appropriate group and either select the Tools > Generate Report… menu 
item or right-click the item and select Generate Report…. 
 

 
 
Enter the output file in the box at the top of dialog, or click the “…” button to 
select a file. The file may be generated in one of three formats: 
 
Output Format Settings 
Plain text De-select the Write as Comma 

Separated Values format check-box 
CSV (Comma-Separated Values) Select the Write as Comma 

Separated Values format check-box 
Microsoft Excel Select the Convert to Excel 

Spreadsheet on completion 
checkbox, which converts the CSV 
output file to Excel format. 

 
 
Note Excel 2000 or later must be installed to generate Excel spreadsheets. 
 
If the output file is in Excel format, the spreadsheet may be opened 
automatically by selecting the Open spreadsheet in Excel on completion 
checkbox. 
 
To generate the output file, click the Generate button or close the dialog by 
clicking the Cancel button. 
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3 TEMPLATES 
The Templates feature of the application allows the administrator to create a set 
of standard permissions to be applied to Mailboxes and Public Folders.  

3.1 The Templates Manager 

The Templates Manager dialog is used to manage your templates. The main 
part of the dialog displays a list of the templates available in the database. The 
view may be changed between icons and a list using the buttons in the toolbar 
at the top of the window. 
 

 
 
The following actions may be performed: 
 

• To create a new template ► click the New button. The Template Wizard 
will be opened in Create mode. 

• To edit an existing template ► select the template from the list, and 
either click the Edit or double-click the template. The Template Wizard 
will be opened in Modify mode. 

• To delete an existing template ► select the template from the list and 
click the Delete button. 

3.2 The Template Wizard 

The Template Wizard is used to either create a new template or modify an 
existing template. The wizard guides you through a series of steps to configure 
the template. At any stage, you may cancel the process by clicking the Cancel 
button to return to the Manager dialog. To proceed to the next step, click the 
Next button, or to return to a previous step, click the Previous button. Once the 
template is correctly configured, the Finish button will become enabled. 
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3.2.1 Welcome 

This step simply welcomes you to the wizard. To prevent it from being displayed 
each time you run the wizard, select the Do not show… check box. 
 
Click the Next button to proceed to the next step. 

3.2.2 Step One – Name and Type of Template 

This step configures the name and type of the template. 
 

 
 
Enter/update the name of the template in the text box at the top of the dialog to 
identify the template in the list. 
 
Choose the type of template from one of the following options: 
 

• Append Mode – only new permissions are added; any existing 
permissions on the folders will remain in place and will not be overwritten 
by the permissions defined in the template. 

• Overwrite mode – all existing permissions (except those of the Default 
and Anonymous users) are removed and overwritten by the permissions 
defined in the template. 

• Overwrite, No Delete mode – all existing permissions are overwritten but 
those not specified in the template will not be removed. 

• Remove – all permissions specified in the list will be removed but other 
existing permissions will not be altered. 
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• Update – all permissions defined in the list will be updated but any that 
do not exist will not be created. 

 
Click the Next button to proceed to the next step. 

3.2.3 Step Two – Modified Objects 

This step configures the objects that can be modified by the template. 
 

 
 
Select the appropriate option for the template depending on whether the 
template should alter Mailboxes only, Public Folders only, or both Mailboxes 
and Public Folders. Your selection here will determine which folders are 
available in Step Three. 

3.2.4 Step Three – Configure Folders and Permissions 

This step configures which folders the template will alter and what permissions 
are applied to those folders (see dialog top of next page). 
 
Select the folders that the template should alter from the list of the left-hand side 
of the dialog. If the same permissions are going to be applied to all selected 
folders, select the Apply the same permissions to all selected folders check 
box. If this check box is unchecked, you must set the permissions individually 
for each selected folder. 
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On the right-hand side of the dialog, the permissions that will be set for each 
folder are displayed. These controls work exactly like the controls on the main 
window, except the Apply… and Refresh… buttons are not available. 
 
Note The Default and Anonymous users can be modified by the template but if 
they do not exist, they will not be created. 
 
Note For a full description of how permissions can be set, see §4.2. 
 
Click the Next button to proceed to the next step. 

3.2.5 Ready to Create/Update Template 

This final step confirms you want to create or update the template you have 
been working on. If you are happy, click the Finish button. Alternatively, you 
may return to any previous step by clicking the Previous button. 

3.2.6 Finished! 

The template has been created or updated. Click the Close button to close the 
wizard and return to the Template Manager window. 

3.3 Applying a Template 

To apply a template to a mailbox, distribution list, address list or Public Folders, 
select the appropriate node in the Exchange system tree of the main application 
window and click the Templates > Apply Template… menu item, or right-click 
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the node and select Apply Template…. This will open the Templates Manager 
dialog in Apply mode. 
 

 
 
The three check-boxes at the bottom of the window control are context-sensitive 
to the type of object selected in the explorer. They will be available as follows: 
 
When a Single Mailbox is Selected 
 

• “Preview Modified Mailboxes” is disabled. 
• “Apply to Sub-Folders”; when checked, any user-created folders within 

the selected top-level folders will be modified. 
 
When a Mailbox Group is Selected 
 
NB. A “Mailbox Group” is a generic term for Distribution and Address Lists 
 

• “Preview Modified Mailboxes”; when checked, will cause a list of the 
mailboxes that will be affected by the changes to be previewed in a 
separate window. 

• “Apply to Sub-Groups”; when checked, all child mailbox groups within the 
selected group will be modified. 

• “Apply to Sub-Folders”; when checked, any user-created folders within 
the selected top-level folders will be modified. 

 
When a Public Folder is Selected 
 

• “Preview Modified Folders”; when checked, will cause a list of the folders 
that will be affected by the changes to be previewed in a separate 
window. 

•  “Apply to Sub-Folders”; when checked, any sub-folders within the 
selected Public Folder will be modified. 
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To apply a template, select it from the list and click the Apply button. After 
confirming the action, the application will apply the template to the selected 
item. Bear in mind this can be a long process for distribution lists and address 
lists with several entries. The progress is displayed in a bar at the bottom-right 
of the window. 
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4 MISCELLANEOUS ISSUES 
This section describes miscellaneous issues that relate to the operation of the 
application. 

4.1 Public Folders and the Owner User 

To prevent the contents of a Public Folder from becoming inaccessible, Folder 
Permissions Manager prevents the removal of the rights Folder Owner, Folder 
Visible and Edit Own Items for the Owner user of a Public Folder who created 
the particular folder. This behaviour is consistent with Outlook. 

4.2 Setting Folder Permissions 

This section describes how to set permissions on folders using the various 
dialogs in the application. These windows are the Main window (§2.2), the 
Template Wizard window (§3.2.4), and the Group Permissions window (§2.5). 

4.2.1 Name/Role 

Displays user names and their permissions for the folder. The default 
permission is the role granted to all general users. 
 
Next to Name/Role box, the following buttons are available: 
 

• Add – Selects user, distribution list, and public folder names to add to the 
Name/Role box. 

• Remove – Removes the selected name from the Name/Role box. 
• Properties –  Displays details about the selected name. 

4.2.2 Permissions 

Specifies a role for the selected name. When you select a role, the permissions 
associated with that role are automatically selected. When you select individual 
permissions, the matching role name appears in the Roles box. If there is no 
matching role, Custom appears. You cannot select Custom; it appears 
automatically. 

4.2.3 Roles 

Specifies a role for the selected name in the Name/Role box. 
 
Role Description 
Owner Grants all permissions in the folder. Create, read, 

modify, and delete all items and files and create 
subfolders. The owner can also change permission 
levels that others have for the folder. 
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Publishing Editor Grants permission to create, read, modify and delete 
all items and files, and create subfolders. 

Editor Grants permission to create, read, modify, and delete 
all items and files. 

Publishing Author Grants permission to create and read items and files, 
modify and delete items and files you create, and 
create subfolders. 

Author Grants permission to create and read items and files, 
and modify and delete items and files you create. 

Nonediting Author Grants permission to create and read items and files.  
Reviewer Grants permission to read items and files only. 
Contributor Grants permission to create items and files only. The 

contents of the folder do not appear. 
Free/Busy Time, 
Location, Subject  

Grants permission to free/busy time, location and 
subject. The contents of the folder do not appear. Only 
available on default calendar folder with Outlook 2007 
and later on Exchange 2007 and later. 

Free/Busy Time Grants permission to free/busy time. The contents of 
the folder do not appear. Only available on default 
calendar folder with Outlook 2007 and later on 
Exchange 2007 and later. 

None Grants no permission in the folder. Use this as the 
default permission when you want to limit the folder 
audience to only users you specifically add to the 
Name/Role box. 

4.2.4 Read Permissions 

The following table describes the effect of the read permissions that can be set. 
 
Permissions Description 
None Grants no permissions. 
Free/Busy Time Grants permission to free/busy time. Only available on 

default calendar folder with Outlook 2007 and later on 
Exchange 2007 and later. 

Free/Busy Time, 
Location, Subject 

Grants permission to free/busy time, location and 
subject. Only available on default calendar folder with 
Outlook 2007 and later on Exchange 2007 and later. 

Full Details Grants permission to open any item in the folder. 

4.2.5 Write Permissions 

The following table describes the effect of the write permissions that can be set. 
 
Option Description 
Create Items Grants permission to post items in the folder. 
Create Subfolder Grants permission to create subfolders in the folder. 
Edit Own Allows you to modify items you create. 
Edit All Allows you to modify any item. 
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4.2.6 Delete Items 

Select one of the following options. 
 
Option Description 
None Does not allow you to delete any item. 
Own Allows you to delete items you create. 
All Allows you to delete any item. 

4.2.7 Other Permissions 

The following table describes the effect of the other permissions that can be set. 
 
Permissions Description 
Folder Owner Grants all permissions in the folder. 
Folder Contact Grants folder contact status. Folder contacts receive 

automated notifications from the folder, such as 
replication conflict messages, as well as requests from 
users for additional permissions or other changes in the 
folder. 

Folder Visible Grants permission to see the folder. 
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5 REQUIRED ACCOUNT PERMISSIONS 
Symprex Folder Permissions Manager requires you to be logged into Windows 
with a domain account that has permissions on Exchange as described below. 

5.1 Exchange 2000/2003 Account Permissions 

To make sure your account has the necessary permissions on Exchange 2000 
or 2003, follow these steps: 
 
Note If your account is a member of the Domain Admins group, and not of any 
of the Exchange security groups, it already has the necessary permissions. 
 
Step 1 
 
Open Exchange System Manager, then: 
 

• Select your server (or mailbox store). 
• Right-click and select Properties to open the Properties dialog. 

 
Step 2 
 
Select the Security tab in the server (or mailbox store) properties dialog, then: 
 

• Add or select your account. 
• Allow the Administer information store right. 

 
Repeat the above steps for appropriate servers (or mailbox stores) as required. 
 
Your account now has the required permissions. 

5.2 Exchange 2007/2010 Account Permissions 

To make sure your account has the necessary permissions on Exchange 2007 
or Exchange 2010, follow these steps: 
 
Note If your account is a member of the Domain Admins group, and not of any 
of the Exchange security groups, it already has the necessary permissions. 
 
Step 1 
 
Open the Exchange Management Shell, then: 
 

• Assign your account the Administer information store right on your 
server (or mailbox store) by executing one of the following commands: 
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To assign the right on your server: 
 
Get-MailboxServer "YourServer" |  
add-adpermission -user "YourAccount" -extendedrights  
ms-Exch-Store-Admin 
 
To assign the right on your mailbox store: 
 
Get-MailboxDatabase "YourServer\YourMdb" |  
add-adpermission -user "YourAccount" -extendedrights  
ms-Exch-Store-Admin 
 
Note that you need to replace YourServer with the name of your server, 
YourMdb with the name of your mailbox store, and YourAccount with 
the account (domain\account) you want to assign the right. 

 
Repeat the above steps for appropriate servers (or mailbox stores) as required. 
 
Your account now has the required permissions. 
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6 CONTACTING SYMPREX 

6.1 Visit Our Web Site 

Our web site provides general information about Symprex and our products: 
http://www.symprex.com 
 
If you experience technical problems with one of our products, please visit our 
support page: 
http://www.symprex.com/support 

6.2 Contact Us by Email 

Please email general enquiries about Symprex or our products to: 
info@symprex.com 
 
Please email sales enquiries to: 
sales@symprex.com 
 
Please email support enquiries to: 
support@symprex.com 

6.3 Contact Your Local Reseller 

Symprex has partners and resellers in most countries. You can find your local 
reseller here: 
http://www.symprex.com/resellers 
 

http://www.symprex.com/�
http://www.symprex.com/support�
mailto:info@symprex.com�
mailto:sales@symprex.com�
mailto:support@symprex.com�
http://www.symprex.com/resellers�

	Table of Contents
	1 Introduction
	1.1 System Requirements
	1.2 Permissions Requirements

	2 Tutorial
	2.1 Getting Started
	2.2 The Main Application Window
	2.3 Menus
	2.3.1 File Menu
	2.3.2 Tools Menu
	2.3.3 Templates Menu
	2.3.4 Help Menu
	2.3.5 Context-Sensitive Menu

	2.4 Options
	2.5 Apply Permissions to Group
	NB. A “Mailbox Group” is a generic term for Distribution and Address Lists

	2.6 Report

	3 Templates
	3.1 The Templates Manager
	3.2 The Template Wizard
	3.2.1 Welcome
	3.2.2 Step One – Name and Type of Template
	3.2.3 Step Two – Modified Objects
	3.2.4 Step Three – Configure Folders and Permissions
	3.2.5 Ready to Create/Update Template
	3.2.6 Finished!

	3.3 Applying a Template
	NB. A “Mailbox Group” is a generic term for Distribution and Address Lists


	4 Miscellaneous Issues
	4.1 Public Folders and the Owner User
	4.2 Setting Folder Permissions
	4.2.1 Name/Role
	4.2.2 Permissions
	4.2.3 Roles
	4.2.4 Read Permissions
	4.2.5 Write Permissions
	4.2.6 Delete Items
	4.2.7 Other Permissions


	5 Required Account Permissions
	5.1 Exchange 2000/2003 Account Permissions
	5.2 Exchange 2007/2010 Account Permissions

	6 Contacting Symprex
	6.1 Visit Our Web Site
	6.2 Contact Us by Email
	6.3 Contact Your Local Reseller



<<

  /ASCII85EncodePages false

  /AllowTransparency false

  /AutoPositionEPSFiles true

  /AutoRotatePages /None

  /Binding /Left

  /CalGrayProfile (Dot Gain 20%)

  /CalRGBProfile (sRGB IEC61966-2.1)

  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)

  /sRGBProfile (sRGB IEC61966-2.1)

  /CannotEmbedFontPolicy /Error

  /CompatibilityLevel 1.4

  /CompressObjects /Tags

  /CompressPages true

  /ConvertImagesToIndexed true

  /PassThroughJPEGImages true

  /CreateJobTicket false

  /DefaultRenderingIntent /Default

  /DetectBlends true

  /DetectCurves 0.0000

  /ColorConversionStrategy /CMYK

  /DoThumbnails false

  /EmbedAllFonts true

  /EmbedOpenType false

  /ParseICCProfilesInComments true

  /EmbedJobOptions true

  /DSCReportingLevel 0

  /EmitDSCWarnings false

  /EndPage -1

  /ImageMemory 1048576

  /LockDistillerParams false

  /MaxSubsetPct 100

  /Optimize true

  /OPM 1

  /ParseDSCComments true

  /ParseDSCCommentsForDocInfo true

  /PreserveCopyPage true

  /PreserveDICMYKValues true

  /PreserveEPSInfo true

  /PreserveFlatness true

  /PreserveHalftoneInfo false

  /PreserveOPIComments true

  /PreserveOverprintSettings true

  /StartPage 1

  /SubsetFonts true

  /TransferFunctionInfo /Apply

  /UCRandBGInfo /Preserve

  /UsePrologue false

  /ColorSettingsFile ()

  /AlwaysEmbed [ true

  ]

  /NeverEmbed [ true

  ]

  /AntiAliasColorImages false

  /CropColorImages true

  /ColorImageMinResolution 300

  /ColorImageMinResolutionPolicy /OK

  /DownsampleColorImages true

  /ColorImageDownsampleType /Bicubic

  /ColorImageResolution 300

  /ColorImageDepth -1

  /ColorImageMinDownsampleDepth 1

  /ColorImageDownsampleThreshold 1.50000

  /EncodeColorImages true

  /ColorImageFilter /DCTEncode

  /AutoFilterColorImages true

  /ColorImageAutoFilterStrategy /JPEG

  /ColorACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /ColorImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000ColorACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000ColorImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasGrayImages false

  /CropGrayImages true

  /GrayImageMinResolution 300

  /GrayImageMinResolutionPolicy /OK

  /DownsampleGrayImages true

  /GrayImageDownsampleType /Bicubic

  /GrayImageResolution 300

  /GrayImageDepth -1

  /GrayImageMinDownsampleDepth 2

  /GrayImageDownsampleThreshold 1.50000

  /EncodeGrayImages true

  /GrayImageFilter /DCTEncode

  /AutoFilterGrayImages true

  /GrayImageAutoFilterStrategy /JPEG

  /GrayACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /GrayImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000GrayACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000GrayImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasMonoImages false

  /CropMonoImages true

  /MonoImageMinResolution 1200

  /MonoImageMinResolutionPolicy /OK

  /DownsampleMonoImages true

  /MonoImageDownsampleType /Bicubic

  /MonoImageResolution 1200

  /MonoImageDepth -1

  /MonoImageDownsampleThreshold 1.50000

  /EncodeMonoImages true

  /MonoImageFilter /CCITTFaxEncode

  /MonoImageDict <<

    /K -1

  >>

  /AllowPSXObjects false

  /CheckCompliance [

    /None

  ]

  /PDFX1aCheck false

  /PDFX3Check false

  /PDFXCompliantPDFOnly false

  /PDFXNoTrimBoxError true

  /PDFXTrimBoxToMediaBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXSetBleedBoxToMediaBox true

  /PDFXBleedBoxToTrimBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXOutputIntentProfile ()

  /PDFXOutputConditionIdentifier ()

  /PDFXOutputCondition ()

  /PDFXRegistryName ()

  /PDFXTrapped /False



  /CreateJDFFile false

  /Description <<



    /BGR <>

    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>

    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>

    /CZE <>

    /DAN <>

    /DEU <>

    /ESP <>

    /ETI <>

    /FRA <>

    /GRE <>



    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)

    /HUN <>

    /ITA <>

    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>

    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>

    /LTH <>

    /LVI <>

    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)

    /NOR <>

    /POL <>

    /PTB <>

    /RUM <>

    /RUS <>

    /SKY <>

    /SLV <>

    /SUO <>

    /SVE <>

    /TUR <>

    /UKR <>

    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)

  >>

  /Namespace [

    (Adobe)

    (Common)

    (1.0)

  ]

  /OtherNamespaces [

    <<

      /AsReaderSpreads false

      /CropImagesToFrames true

      /ErrorControl /WarnAndContinue

      /FlattenerIgnoreSpreadOverrides false

      /IncludeGuidesGrids false

      /IncludeNonPrinting false

      /IncludeSlug false

      /Namespace [

        (Adobe)

        (InDesign)

        (4.0)

      ]

      /OmitPlacedBitmaps false

      /OmitPlacedEPS false

      /OmitPlacedPDF false

      /SimulateOverprint /Legacy

    >>

    <<

      /AddBleedMarks false

      /AddColorBars false

      /AddCropMarks false

      /AddPageInfo false

      /AddRegMarks false

      /ConvertColors /ConvertToCMYK

      /DestinationProfileName ()

      /DestinationProfileSelector /DocumentCMYK

      /Downsample16BitImages true

      /FlattenerPreset <<

        /PresetSelector /MediumResolution

      >>

      /FormElements false

      /GenerateStructure false

      /IncludeBookmarks false

      /IncludeHyperlinks false

      /IncludeInteractive false

      /IncludeLayers false

      /IncludeProfiles false

      /MultimediaHandling /UseObjectSettings

      /Namespace [

        (Adobe)

        (CreativeSuite)

        (2.0)

      ]

      /PDFXOutputIntentProfileSelector /DocumentCMYK

      /PreserveEditing true

      /UntaggedCMYKHandling /LeaveUntagged

      /UntaggedRGBHandling /UseDocumentProfile

      /UseDocumentBleed false

    >>

  ]

>> setdistillerparams

<<

  /HWResolution [2400 2400]

  /PageSize [612.000 792.000]

>> setpagedevice



